Adobe Captivate 8: Beyond the Essentials

“Skills and Drills” Learning

Kevin Siegel
Contents
About This Book
The Author ........................................................................................... vii
Book Conventions.................................................................................. viii
Confidence Checks................................................................................ viii
Book and Captivate System Requirements ................................................. ix
Data Files (Captivate Project Assets).......................................................... x
  Download the Windows Data Files ........................................................................ x
  Download the Mac Data Files ................................................................ xii
How Software Updates Affect This Book.................................................... xii
Contacting IconLogic.............................................................................. xii
Special Thanks...................................................................................... xii

Preface
To Review or Not to Review ................................................................. 2
Planning eLearning Projects ..................................................................... 3
The Development Process ......................................................................... 4
Resolution and Recording Size ............................................................... 7
Captivate’s Preferences ............................................................................ 8
  Reset Captivate’s Preferences ........................................................................ 8

Module 1: Caption Pre-Editing
Rehearsals ........................................................................................... 10
  Rehearse a Script........................................................................... 11
Software Simulations ............................................................................. 12
  Set Recording Preferences ......................................................................... 12
  Specify a Recording Area .......................................................................... 15
  Target an Application...................................................................... 16
  Target a Screen Area...................................................................... 17
  Record Screen Actions .................................................................... 18
  Custom Recording Confidence Check.......................................... 19
Caption Pre-Editing................................................................................ 20
  Edit a Text Capture Template........................................................... 20
  RDL Editing Confidence Check................................................... 23

Module 2: Video Demos
Working with Video Demos ..................................................................... 26
  Record a Video Demo ..................................................................... 28
Zooming and Panning ............................................................................ 32
  Add a Video Zoom.......................................................................... 32
  Add a Video Pan............................................................................. 35
  Pan & Zoom Confidence Check .................................................. 37
Mouse Points ........................................................................................ 38
  Smooth a Mouse Path and Show Visual Clicks .................................... 38
Splitting ............................................................................................... 40
  Split a Video.................................................................................. 40
  Transitions Confidence Check .................................................... 41
Trimming ............................................................................................... 42
  Trim a Video.................................................................................. 42
  Trimming Confidence Check...................................................... 43

Module 3: Branching and Aggregating
Object Styles ........................................................................................ 46
  Create a New Style......................................................................... 46
  Apply an Object Style Globally .......................................................... 50
Sharing Styles ...................................................................................... 51
  Export/Import a Style................................................................... 51
Contents

Styles Confidence Check ...........................................................53
Combining Projects ..................................................................................54
Name a Slide ..................................................................................54
Naming Slides Confidence Check ..................................................55
Copy/Paste Project Assets ...............................................................56
Branching ............................................................................................57
Use Buttons to Create a Branch ............................................................57
Branching Confidence Check ..............................................................58
Explore the Branching View ...............................................................59
Groups .................................................................................................62
Create a Slide Group ........................................................................62
Aggregating .............................................................................................64
Publish SWFs .....................................................................................64
Publishing Confidence Check .............................................................65
Aggregate SWFs ................................................................................66
Aggregator Confidence Check ............................................................67

Module 4: Random Quizzes
GIFT Files .............................................................................................70
Review a GIFT File ........................................................................70
Import a GIFT File into a Project .......................................................71
Question Pools ......................................................................................72
Create Question Pools .......................................................................72
Question Pools Confidence Check ....................................................73
Move Questions to Pools ..................................................................74
Moving Questions to Pools Confidence Check ......................................75
Random Question Slides .........................................................................76
Insert Random Question Slides............................................................76
Random Questions Confidence Check ................................................77

Module 5: Accessible eLearning
Accessibility and Captivate ......................................................................80
Set Document Information ................................................................81
Enable Accessibility ...........................................................................82
Accessibility Text ................................................................................83
Add Accessibility Text to Slides ..........................................................83
Import Slide Audio ...........................................................................85
Accessibility Text Confidence Check ................................................86
Shortcut Keys ......................................................................................88
Add Shortcut Keys ............................................................................88
Keyboard Shortcut Confidence Check ................................................89
Closed Captioning ..............................................................................91
Add Closed Captions .......................................................................91
Closed Captions Confidence Check ..................................................94
Tab Order ..............................................................................................97
Set a Tab Order ..................................................................................97
Tab Order Confidence Check ...........................................................99

Module 6: Variables and Widgets
Variables ............................................................................................102
Add Project Information .................................................................102
Insert a System Variable ................................................................103
Variable Preview Confidence Check ................................................104
Edit a System Variable .....................................................................105
System Variables Confidence Check ................................................106
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Variables</td>
<td>107</td>
</tr>
<tr>
<td>Create a User Variable</td>
<td>107</td>
</tr>
<tr>
<td>Use a Variable to Gather Learner Data</td>
<td>109</td>
</tr>
<tr>
<td>User-Defined Variables Confidence Check</td>
<td>111</td>
</tr>
<tr>
<td>Widgets</td>
<td>112</td>
</tr>
<tr>
<td>Insert and Format a Widget</td>
<td>112</td>
</tr>
<tr>
<td>Widget Confidence Check</td>
<td>113</td>
</tr>
<tr>
<td>Learning Interactions</td>
<td>115</td>
</tr>
<tr>
<td>Insert a Process Circle</td>
<td>115</td>
</tr>
<tr>
<td>Interactions Confidence Check</td>
<td>118</td>
</tr>
<tr>
<td><strong>Module 7: Actions</strong></td>
<td></td>
</tr>
<tr>
<td>Standard Actions</td>
<td>120</td>
</tr>
<tr>
<td>Use a Completed Action</td>
<td>120</td>
</tr>
<tr>
<td>Name Objects</td>
<td>123</td>
</tr>
<tr>
<td>Naming Objects Confidence Check</td>
<td>124</td>
</tr>
<tr>
<td>Create a Mask</td>
<td>125</td>
</tr>
<tr>
<td>Control Object Visibility</td>
<td>126</td>
</tr>
<tr>
<td>Visibility Confidence Check</td>
<td>126</td>
</tr>
<tr>
<td>Create a Simple Action</td>
<td>127</td>
</tr>
<tr>
<td>Simple Action Confidence Check</td>
<td>129</td>
</tr>
<tr>
<td>Attach an Action to a Button</td>
<td>130</td>
</tr>
<tr>
<td>Group Timeline Objects</td>
<td>131</td>
</tr>
<tr>
<td>Editing Actions Confidence Check</td>
<td>135</td>
</tr>
<tr>
<td>Conditional Actions</td>
<td>136</td>
</tr>
<tr>
<td>Create a Variable</td>
<td>136</td>
</tr>
<tr>
<td>Create a Conditional Action</td>
<td>140</td>
</tr>
<tr>
<td>Conditional Actions Confidence Check</td>
<td>144</td>
</tr>
<tr>
<td>Multiple Decision Blocks</td>
<td>145</td>
</tr>
<tr>
<td>Create Decision Blocks</td>
<td>145</td>
</tr>
<tr>
<td>Decision Blocks Confidence Check</td>
<td>147</td>
</tr>
<tr>
<td>Shared Actions</td>
<td>152</td>
</tr>
<tr>
<td>Create and Export a Shared Action</td>
<td>152</td>
</tr>
<tr>
<td>Import a Shared Action</td>
<td>154</td>
</tr>
<tr>
<td><strong>Module 8: Masters, Themes, and Templates</strong></td>
<td></td>
</tr>
<tr>
<td>Masters</td>
<td>158</td>
</tr>
<tr>
<td>Work With the Main Master Slide</td>
<td>158</td>
</tr>
<tr>
<td>Work With Content Masters</td>
<td>159</td>
</tr>
<tr>
<td>Apply a Master to Filmstrip Slides</td>
<td>161</td>
</tr>
<tr>
<td>Edit a Master</td>
<td>162</td>
</tr>
<tr>
<td>Masters Confidence Check</td>
<td>163</td>
</tr>
<tr>
<td>Themes</td>
<td>165</td>
</tr>
<tr>
<td>Apply a Theme</td>
<td>165</td>
</tr>
<tr>
<td>Themes Confidence Check</td>
<td>166</td>
</tr>
<tr>
<td>Create a Custom Theme</td>
<td>167</td>
</tr>
<tr>
<td>Templates</td>
<td>170</td>
</tr>
<tr>
<td>Review a Template</td>
<td>170</td>
</tr>
<tr>
<td>Base a Project on a Template</td>
<td>173</td>
</tr>
<tr>
<td>Create a Project Template</td>
<td>175</td>
</tr>
<tr>
<td>Template Confidence Check</td>
<td>177</td>
</tr>
<tr>
<td>Template Placeholders</td>
<td>178</td>
</tr>
<tr>
<td>Insert a Placeholder</td>
<td>178</td>
</tr>
</tbody>
</table>
## Module 9: Responsive Projects
- Being Responsive ................................................................. 180
  - Review a Responsive Project .............................................. 180
  - Customize Break Points ....................................................... 182
    - Break Points Confidence Check ........................................ 185
- Creating Responsive Projects ................................................. 186
  - Customize Theme Colors ..................................................... 186
- Editing a Responsive Project .................................................... 189
  - Use the Position Inspector .................................................. 189
- Positioning Objects ............................................................... 195
  - Position and Link Objects ................................................... 195
    - Object Position Confidence Check ..................................... 198

## Module 10: Reporting Results
- LMS Reporting Options .......................................................... 202
  - Set Quiz Reporting Options .................................................. 203
- Manifest Files ........................................................................ 205
  - Create a Manifest File ......................................................... 205
- Advanced Interaction ............................................................. 207
  - Report a Button Interaction .................................................. 207
  - Adjust Slide Object Interaction ............................................. 208
- Content Packages .................................................................... 209
  - Publish a Content Package .................................................. 209
- Uploading to an LMS ............................................................... 211
  - Create an Inquisiq LMS Account ............................................ 212
  - Create an LMS Course .......................................................... 215
  - Attach a Lesson to a Course .................................................. 216
  - Create an LMS Catalog .......................................................... 219
  - Attach a Course to a Catalog .................................................. 220
  - Test an eLearning Course ..................................................... 221
About This Book

This Section Contains Information About:

- The Author, page vii
- Book Conventions, page viii
- Confidence Checks, page viii
- Book and Captivate System Requirements, page ix
- Data Files (Captivate Project Assets), page x
- How Software Updates Affect This Book, page xii
- Contacting IconLogic, page xii

The Author

Kevin Siegel is the founder and president of IconLogic, Inc. He has written hundreds of step-by-step computer training books on applications such as Adobe Captivate, Adobe RoboHelp, Adobe Presenter, Adobe Technical Communication Suite, Adobe Dreamweaver, Adobe InDesign, Microsoft Word, Microsoft PowerPoint, QuarkXPress, and TechSmith Camtasia Studio.

Kevin spent five years in the U.S. Coast Guard as an award-winning photojournalist and has nearly three decades experience as a print publisher, technical writer, instructional designer, and eLearning developer. He is a certified technical trainer, a veteran classroom instructor, and a frequent speaker at trade shows and conventions.

Kevin holds multiple certifications from companies such as Adobe and CompTIA. You can reach Kevin at ksiegel@iconlogic.com.
Book Conventions

I believe that learners learn by doing. With that simple concept in mind, IconLogic books are created by trainers/authors with years of experience training adult learners. Before IconLogic books, our instructors rarely found a book that was perfect for a classroom setting. If the book was beautiful, odds were that the text was too small to read and hard to follow. If the text in a book was the right size, the quality of exercises left something to be desired.

Finally tiring of using inadequate materials, our instructors started teaching without any books at all. Years ago we had many students ask if the in-class instruction came from a book. If so, they said they’d buy the book. That sparked an idea. We asked students—just like you—what they wanted in a training manual. You responded, and that methodology is used in this and every IconLogic training manual.

This book has been divided into several modules. Because each module builds on lessons learned in a previous module, I recommend that you complete each module in succession. Each module will guide you through lessons step-by-step. Here is the lesson key:

☐ instructions for you to follow will look like this

If you are expected to type anything or if something is important, it will be set in bold type like this:

☐ type 9 into the text field

When you are asked to press a key on your keyboard, the instruction will look like this:

☐ press [shift]

I hope you enjoy the book. If you have any comments or questions, please see page xii for our contact information.

Confidence Checks

As you move through the lessons in this book, you will come across the little guy at the right. He indicates a Confidence Check. Throughout each module, you will be guided through hands-on, step-by-step exercises. But at some point you’ll have to fend for yourself. That is where Confidence Checks come in. Please be sure to complete each of the challenges because some exercises build on completed Confidence Checks.
Book and Captivate System Requirements

The Adobe Captivate 8 software does not come with this book. The software can be downloaded directly from Adobe (www.adobe.com/products/captivate.html). You do not need to purchase Captivate to learn Captivate; the free trial version of the software can be downloaded via the link above. The only limitation on the trial is that it will last for 30 days from the day you first run the software on your computer.

Here are Adobe’s system requirements for installing and using Adobe Captivate 8.

**Windows:** 1 GHz or faster processor Intel Pentium 4, Intel Centrino, Intel Xeon, or Intel Core Duo (or compatible) processor; Microsoft Windows 7 with Service Pack 1, Windows 8, or 8.1; 2GB minimum RAM (4GB recommended); 5GB of available hard-disk space for installation; additional free space required during installation (cannot install on flash-based storage devices); 1024x768 display (1280x1024 recommended) with 16-bit video card.

**Mac:** Multicore Intel processor; Mac OS X 10.9 or newer; 2GB minimum RAM (4GB recommended); 5GB of available hard-disk space for installation; additional free space required during installation (cannot install on a volume that uses a case-sensitive file system or on flash-based storage devices); 1024x768 display (1280x1024 recommended) with 16-bit video card.

**Speakers, and/or a Headset:** You learn about “Accessible eLearning” on page 79. During that module, you import audio files and learn how to create closed captions. You need speakers (or a headset) to complete those activities.
Data Files (Captivate Project Assets)

The only thing you need to use this book is Adobe Captivate 8, some Captivate 8 projects, images, and audio files. Fortunately, I’ve got all of those assets ready to go, and you can download them from the Iconlogic website for free.

**Windows users:** Work through the activity below.

**Mac users:** Skip the activity below and move on to page xi.

Student Activity: Download the Windows Data Files

1. Download the student data files necessary to complete the lessons presented in this book.
   - start a web browser and visit the following web address: [http://www.iconlogic.com/pc](http://www.iconlogic.com/pc)
   - click the **Captivate 8: Beyond The Essentials** link

2. Save the file to your computer. After the file downloads, close the web browser.

3. Extract the data files.
   - find the **Captivate8BeyondData** file you just downloaded to your computer
   - double-click the file to execute it (even though the file is an EXE file, it’s not a program; rather it’s an archive containing zipped data files)
   - if presented with a Security Warning dialog box, click **Run** or **Yes**

The WinZip Self Extractor opens.

- confirm **C:** appears in the **Unzip to Folder** area (only change the **Unzip to folder** if you are prohibited from installing assets directly to your C drive)

![WinZip Self Extractor](image)

- click the **Unzip** button

You will be notified that more than 100 files were unzipped.

- click the **OK** button and then click the **Close** button

A **Captivate8BeyondData** folder has been installed on your computer. As you move through the lessons in this book, you will be working with the files within this folder. You can skip the next activity and turn to page xii.
Student Activity: Download the Mac Data Files

1. Download the student data files necessary to complete the lessons presented in this book.
   - start your web browser and go to the following web address: http://www.iconlogic.com/mac
   - click the Captivate 8: Beyond The Essentials link
   
   The zipped data files are typically downloaded to the Downloads folder on your Mac and automatically extracted into a folder named Captivate8BeyondData.

2. Move the data files folder to your desktop.
   - find the Captivate8BeyondData folder and drag it to your desktop

Before starting the lessons in Module 1 of this book, it’s a good idea to review “How Software Updates Affect This Book” on page xii.
How Software Updates Affect This Book

This book was written specifically to teach you how to use Adobe Captivate version 8.0. At the time this book was written, Captivate 8 was the latest and greatest version of the Captivate software available from Adobe.

With each major release of Captivate, my intention is to write a new book to support that version and make it available within 30-60 days of the software being released by Adobe. From time to time, Adobe makes service releases/patches of Captivate available for customers that fix bugs or add functionality. For instance, I would expect Adobe to update Captivate 8 with a patch or two within a few months of Captivate 8 being released. That patched version might be called Captivate 8.01 or 8.1. Usually these updates are minor (bug fixes) and have little or no impact on the lessons presented in this book. However, every so often Adobe makes significant changes to the way Captivate looks or behaves, even with minor patches. (Such was the case when Adobe updated Captivate from version 5 to 5.5—about a dozen features were added, and a few panels were actually renamed, throwing readers of my books into a tizzy.)

Because it is not possible for me to recall and update printed books, some instructions you are asked to follow in this book may not match the patched/updated version of Captivate that you might be using. If something on your screen does not match what I am showing in the book, please visit the Adobe Captivate 8 product page on my website for possible updates (http://www.iconlogic.com/adobe-captivate-8-beyond-essentials-workbook.html).

Contacting IconLogic

IconLogic, Inc.
3320 Breckenridge Way | Riva, MD  21140 | 410.956.4949
Web: www.iconlogic.com | Email: info@iconlogic.com

Special Thanks

Ellie Abrams (ellie@esatraininginc.com) offered her considerable proofreading skills to purge as many grammar errors from this book as possible.

Anita Horsley (anitahorsley@gmail.com) wrote the section on Responsive Projects, which begins on page 179.

Jill McGilien (www.nextturnconsulting.com) donated the projects you will aggregate during lessons beginning on page 61. Jill’s company, Next Turn Consulting, is a training company specializing in improving communication, leadership, and results.

Lori Smith, IconLogic’s lead eLearning developer, created the Advanced Actions activities you will work through beginning on page 119.

Finally, some awesome beta testers helped track down and eliminate as many errors as possible from this book. Specifically I’d like to thank my top bug hunters: Justin Hamburg, Michelle Jackson, Barbara Ash, John Moon, Nina Winer, Michael Mizen, and AJ Walther.
Rank Your Skills

Before starting this book, complete the skills assessment on the next page.
## Skills Assessment

### How This Assessment Works

Below you will find 10 course objectives for *Adobe Captivate 8: Beyond The Essentials*. Before starting the book: Review each objective and rank your skills using the scale next to each objective. A rank of 1 means No Confidence in the skill. A rank of 5 means Total Confidence. After you’ve completed this assessment, go through the entire book. After finishing the book: Review each objective and rank your skills now that you’ve completed the book. Most people see dramatic improvements in the second assessment after completing the lessons in this book.

### Before-Class Skills Assessment

<table>
<thead>
<tr>
<th>Objective</th>
<th>Rank</th>
<th>Rank</th>
<th>Rank</th>
<th>Rank</th>
<th>Rank</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. I can edit a Text Capture Template.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>2. I can create a Slide Group.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>3. I can aggregate published SWFs.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>4. I can create Question Pools.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>5. I can add Accessibility Text to slides.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>6. I can create a Responsive Project.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>7. I can create a User Variable.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>8. I can create a Master Slide.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>9. I can create a Conditional Action.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>10. I can create a Manifest File.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
</tbody>
</table>

### After-Class Skills Assessment

<table>
<thead>
<tr>
<th>Objective</th>
<th>Rank</th>
<th>Rank</th>
<th>Rank</th>
<th>Rank</th>
<th>Rank</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. I can edit a Text Capture Template.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>2. I can create a Slide Group.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>3. I can aggregate published SWFs.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>4. I can create Question Pools.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>5. I can add Accessibility Text to slides.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>6. I can create a Responsive Project.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>7. I can create a User Variable.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>8. I can create a Master Slide.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>9. I can create a Conditional Action.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>10. I can create a Manifest File.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
</tbody>
</table>

---

**IconLogic, Inc.**
3320 Breckenridge Way, Riva, MD 21140
www.iconlogic.com
Preface

This Section Covers:

- To Review or Not to Review, page 2
- Planning eLearning Projects, page 3
- The Development Process, page 4
- Resolution and Recording Size, page 7
- Captivate’s Preferences, page 8
To Review or Not to Review

This book is a companion to Adobe Captivate 8: The Essentials released in June 2014. In that book, my goal was to get you up and running using Captivate as quickly as possible. The finished book tipped the scales at just under 250 pages. After completing that book, readers had a fair grasp of how to both record and produce eLearning lessons using Adobe Captivate. However, there was a ton of stuff that just wouldn’t fit into that book, nor was it appropriate to include many of those lessons into a beginner, or essentials, book.

In this book, I’m going to teach you many of the features and functions that I wasn’t able to cover in Adobe Captivate 8: The Essentials. But where to start? My assumption is that if you’ve purchased this book, you already have most of the essential Captivate skills under your belt. But that could be a very bad assumption. Maybe you’ve forgotten all of the cool stuff I taught you in that book. Maybe you’ve taught yourself Captivate and have skipped the Adobe Captivate 8: The Essentials book and have started with this book.

Again, I’ve got to ask this question: Where do I start? Instead of jumping right into the advanced concepts, let’s spend some time reviewing the essential information about Adobe Captivate and the production process. Then I’ll guide you through the process of using Captivate to record screen actions.

Some of the information you are about to read in this first module is taken directly from the first few modules in Adobe Captivate 8: The Essentials, where you learn about Captivate’s recording modes. Even though much of the content is review, I urge you to read through this section and complete the activities... it will be well worth your time.

What Is Adobe Captivate?

Using Adobe Captivate, you can create eLearning lessons from just about anything you can access from your computer. The lessons you create can be interactive—you can add captions, rollovers, slidelets, clickable areas, typing areas, animation, Flash Video, widgets, variables, sound effects, and more.

Captivate projects can be published as Small Web Format (SWF) files, HTML5, MP4 videos, Microsoft Word documents, and Adobe PDFs. The published SWFs and HTML5 files are cross-platform, meaning they can be viewed on just about any computer platform via a web browser (such as Google Chrome, Mozilla FireFox, Internet Explorer, or Apple Safari). You can add user variables to a project to engage the learner at a personal level (page 101), and you can create eLearning content that is accessible to learners with disabilities (page 79). You can also use Captivate to create responsive eLearning (lessons that will reflow to fit on multiple display sizes). You’ll learn about that beginning on page 179.
Planning eLearning Projects

By the time you finish the last lesson in this book, you should be able to use Captivate to create some compelling, technically sound eLearning lessons. However, just because you will soon be able to publish technically sound content does not necessarily mean you will go out and create good eLearning lessons. If you want to create good, useful lessons, you have to plan ahead. Before recording your first real video using Captivate, you should ask yourself the following questions:

- Why are you creating an eLearning course? You’d be surprised how many people start Captivate and just start creating content. This kind of development process might be well-intentioned, but you really need to map out the entire course, including how you are going to track learner comprehension (if that’s important to you). During the mapping process, you might come to the conclusion that your course simply isn’t appropriate for eLearning.

- Who is your audience? The way you teach children is different from the way you teach adults. For instance, children need praise and encouragement during the learning process that an adult learner might find annoying, if not down-right obnoxious.

- Not every lesson in an instructor-led lesson can be effectively re-tooled as an eLearning lesson. For instance, if a course relies on breakout groups, group discussion, or collaborative work, those aspects of the course cannot be included in eLearning. Keep in mind that eLearners almost always work on their own with little or no interaction with a colleague.

- Does your project need to accommodate learners with disabilities? If the answer is yes, you should budget approximately 30 percent more time to produce each lesson. Although it’s not difficult to create accessible eLearning, it takes time.

- Do you want your projects to contain images and background music? If so, where will you get them? Also, are you going to use a template? If so, who is going to design/create it?

- Will there be captions (written instructions and descriptions)? If so, who will write the content for these captions? Do you need an eLearning script? Do you need a voiceover script?

- Is your course soft-skills, or is it a software simulation? If it is soft-skills, does it make sense to create most of the content in Microsoft PowerPoint and then import the presentation into Captivate?
The Development Process

I’ve listed the typical eLearning development process below. The list includes a skill level number indicating the level of difficulty for each task. The numbers range from 1 to 10, with 10 indicating the most difficult task.

- **Write It:** If you’re not a writer, you’ll need someone to write the step-by-step instructions (also known as a script or storyboard) necessary to record the project in Captivate. You’ll typically find technical writers doing this kind of work, and I consider this the most important process. Without a good script, you don’t have a movie. Think I’m kidding? The lack of a viable script doomed such movie classics as *Battlefield Earth, Barb Wire, Heaven’s Gate, Popeye,* and *Ishtar.* *(Skill Level: 10)*

- **Rehearse It:** Go through the script with the software you’ll be recording in front of you. Don’t skip any steps. You’ll be able to see if the steps in the script are incomplete or inaccurate before you attempt to record the steps using Captivate. *(Skill Level: 2)*

- **Reset It:** After rehearsing the steps, be sure to “undo” everything you did. Few things are more frustrating than recording your movie only to find a step you intend to record has already been completed. *(Skill Level: 1)*

- **Record It:** If rehearsals go well, recording the steps should be easy. *(Skill Level: 1)*

- **Produce It:** This is where you use Captivate to add captions, highlight boxes, text entry fields, spell check, add buttons, click boxes, animation, question slides, audio, variables, advanced actions, etc. *(Skill Level: 8)*

- **Publish It:** Although not a difficult task, if your project is large (lots of slides and audio), publishing could take some time. You cannot do any work in Captivate while your project is publishing. *(Skill Level: 1)*

- **Post It:** This is a broad category. Posting your project means different things depending on where your finished lessons are supposed to go. For instance, if your lessons are supposed to be uploaded into a Learning Management System (LMS), you have to set up the reporting features in Captivate, publish the project, and then upload into the LMS. Then you need to test the lesson to ensure it scores correctly. If you plan to simply add the lessons to a web server, posting may be as simple as handing the published files off to your webmaster. *(Skill Level: 2 or 3... or higher if your LMS is difficult to use)*

- **Test It:** This task isn’t difficult, but it could take time. If you find a problem, you’ve got to go back and clean it up, publish it, and retest it. Some people argue that this step belongs above the Publish It process. I cannot argue with that logic. However, after testing the project, you still need to publish it, and, as I mentioned above, if you’re working with an LMS, upload it and test again. Maybe it should be Test It, Publish It, Test It. See how easy I am? *(Skill Level: 2)*

- **Republish, Repost, Retest:** If something doesn’t work when you test the posted version of your lesson, you have to return to Captivate and fix the problem. After that, you’ll Publish, Post, and Test again. Although this may not be a difficult process, it could take time. *(Skill Level: 2 or 3... or higher if you can’t resolve the problem)*
Budgeting Considerations

Many new Captivate developers underestimate the time needed to produce projects. Although it is certainly easier and faster to create eLearning content than ever before, it still takes time. To determine your level of effort, the first thing you need to know is how long you want your eLearning course to play—in minutes. Once you have that number, you can calculate your level of effort.

For the sake of argument, let’s calculate how long it’s going to take you to produce a 60-minute eLearning course. Because you don’t want to create a single project that, when published, plays for 60 minutes, it’s ideal to break the 60 minutes of content into chunks. I’d suggest that each chunk play for no more than five minutes. That means you will have 12, five-minute lessons.

If you need to write the content for the course (somebody has to), you’ll need a script and/or storyboard, and, if there’s voiceover audio, you’ll need a voiceover script. **Storyboards** are rough sketches that show the general content of your project, slide by slide. If your projects contain more screen shots of an application than captions, a storyboard is a good idea. **Scripts** are detailed step-by-step procedures. These are ideal if your project will contain a significant number of Text Captions. **Voiceover scripts** are important because you don’t want the narrator simply reading aloud the text displayed on the screen. Studies have shown that a narrator simply reading the text being displayed is a distraction to the learner.

It could take at least three hours to write a script to support a five-minute eLearning course. Therefore, you should budget at least 36 hours to write the entire one-hour eLearning course (12 x 3=36). Depending on how fast you write, you could easily double those hours, meaning you may need to budget 80 hours for writing.

You can and should use a Captivate project template when creating content in Captivate. A template is essentially a completed shell project that you will use as the basis of all of your projects. It’s not difficult to create a template, but it takes time. An ideal template contains placeholders, an introduction slide, transitional slides, a conclusion slide, a skin, and appropriate Start and End Properties (although these terms may seem foreign to you now, you will learn about many of them as you move through lessons presented in this book).

In my experience, writing a voiceover script is easier than writing a step-by-step main script (voiceover scripts typically take me 50 percent less time to write). If you spent 80 hours writing the script, you should budget 40 hours to write the voiceover script. Once the voiceover script is done, you’ll also need to include time for recording the audio narration (voice-overs), making corrections to the script post-rehearsal, resetting the stage prior to recording, and recording the lessons using Captivate (the recording time should take the same amount of time as the process being recorded).

As I mentioned above, at two hours of production for every minute of eLearning, it could easily take 10 hours to produce a five-minute Captivate lesson. During the production process, you will likely need to add and/or edit text captions (which you will learn about beginning on page 64). Typical Captivate projects include interactive objects such as click boxes (page 173), buttons (page 31), and text entry boxes (page 177). And a typical lesson should include a quiz to measure learner comprehension of the content (you will learn about quizzes beginning on page 193).

During the production process, you’ll likely add audio clips to the project’s background, individual slides, and even objects on individual slides. It’s also likely that you’ll either record voiceover audio (or use Captivate’s Text to Speech feature to convert written text to voiceover audio. And you’ll likely need to edit the audio files
by performing such common tasks as removing unwanted noise. (You will learn to work with audio on page 133.)

Finally, you’ll need to publish the finished project into any one of several output formats, possibly uploading those files to a server or LMS and testing for scoring or interactivity errors. After that, you’ll need to fix problems (and there will likely be plenty of problems that need to be fixed). After fixing those problems, you’ll need to republish, repost, and then retest. (You will learn to Publish projects beginning on page 221.)

Your eLearning development budget (to create a 60-minute eLearning course) might look something like this:

- 40-80 hours to write an eLearning script or create the storyboard to support 12, five-minute lessons for a one-hour course.
- 120 hours to edit, produce, and test 12, five-minute lessons (two hours for every minute of playtime).
- 20-40 hours to write a narration script to be used by your narrator.
- 20-40 hours to record and enhance voice narration (less if you use Text to Speech, which you will learn about on page 151).

**Note:** Responsive eLearning is new to Adobe Captivate 8 (see page 179). Because you have to worry about multiple layouts for each slide (instead of just a single slide layout with standard projects), a responsive eLearning project could take you longer to produce than a standard Captivate project. You should plan on additional production time if you plan to create responsive content. (Some developers are reporting that responsive layouts take 15-50% longer to produce than standard Captivate projects.)
Resolution and Recording Size

During the first module, you will get a refresher on using Adobe Captivate to record a software simulation. During the recording process, you will perform a few commands on your computer, and provided Captivate is running and recording, every click you make with your mouse will result in one screen capture (also known as a screen shot).

Prior to recording a software simulation, you should be aware of two things that control how sharp and how large your Captivate screen captures will be: Display Resolution and Recording Area.

Display Resolution

A computer monitor (display) is measured in pixels, little squares that are the basic component of a computer graphic. According to www.w3schools.com, the trend in monitor display resolution is higher than 1024 x 768 pixels. If a monitor is set to show more pixels, it is known as increasing the resolution. At a higher resolution, graphics and text look sharper, but smaller. The fewer pixels, the lower the resolution and the larger the screen elements appear.

If your computer is set to a high resolution (such as 1280 x 1024) when you record screen captures using Adobe Captivate, a learner viewing your published lesson on a display using a lower display resolution (such as 1024 x 768) may be forced to scroll significantly to see the action you recorded. Prior to recording screen actions, you should set your computer display to the same resolution (or perhaps a slightly lower resolution) that you expect your learners to be using. Of course, that doesn’t mean that you should set the resolution so low that your display looks terrible—use your best judgment. If you are creating eLearning lessons for internal employees, your corporate IT department likely knows the typical display size and resolution used on computers in your organization. If your lessons are intended for the public at large, you need to take a best guess as to the typical display resolution your customers will be using. Alternatively, you can survey your users to learn their screen resolutions, but surveys may not be practical in your environment.

Recording Area

The Recording Area is not the same thing as Display Resolution (although the two settings are often confused). The Display Resolution is controlled via your computer’s Display settings. In contrast, the Recording Area is set from within Captivate and is the physical amount of the screen that you will be capturing during the recording process. Although there are several preset sizes available within Captivate, you can specify your own custom size.

Browser Wars

According to www.w3schools.com, Google Chrome is the world’s most popular web browser. Mozilla Firefox sits firmly in second place, Internet Explorer is in third, and Apple Safari is in fourth. I encourage you to install each of the browsers on your computer and test your eLearning lessons in all of them. You should also test your published lessons on a PC, a Mac, and a mobile device (such as an iPad) to ensure the lessons perform as expected.
Captivate’s Preferences

Adobe Captivate, like most computer programs, can behave poorly. I’ve found that when Captivate gets sluggish on my computer or crashes, it’s because I’ve got too many applications running and not enough resources. In that instance, closing all nonessential applications solves the problem.

However, there are times when nothing I do seems to help improve Captivate's performance (not even a system reboot). In those rare instances, I’ve found that resetting all of Captivate's Preferences cures what ails Captivate.

If you need to reset Captivate's Preferences, you'll appreciate an obscure utility that ships with Captivate that will reset all of the Preferences for you. Prior to beginning the first module in this book, I’d encourage you to reset your Captivate preferences so that your Captivate settings match those shown in the book.

Student Activity: Reset Captivate’s Preferences

1. Ensure that Adobe Captivate isn’t running.

2. Reset Captivate’s Preferences.
   - navigate to the folder where Captivate is installed on your computer

   **Note:** On Windows, the default location is typically `C:\Program Files\Adobe\Adobe Captivate 8 (32 Bit or 64 Bit)`. On a Macintosh, the default location is typically `Applications > Adobe Captivate 8`

   - open the **utils** folder

   ![Utils folder]

   You’ll find two files of particular interest within the **utils** folder: `CleanPreferencesMac` and `CleanPreferencesWin.bat`.

   - double-click the file appropriate for your operating system

   All of Captivate’s application Preferences will be reset to the way they were the first day Captivate was installed on your computer.
Module 1: Caption Pre-Editing

In This Module You Will Learn About:

- Rehearsals, page 10
- Software Simulations, page 12
- Caption Pre-Editing, page 20

And You Will Learn To:

- Rehearse a Script, page 11
- Set Recording Preferences, page 12
- Specify a Recording Area, page 15
- Record Screen Actions, page 18
- Edit a Text Capture Template, page 20
Rehearsals

As mentioned in the Preface, the Write It phase (page 4), or script development phase, is the most important and difficult part of the eLearning development process. After the Write It phase, you should rehearse the script to ensure that the script is accurate and that every click you are expected to make during the recording process works as written.

Here’s the scenario for a series of recordings you are about to create: you have been hired to create an eLearning course that teaches new employees at your company how to use Notepad (Windows) or TextEdit (Macintosh). One of the lessons you plan to record using Captivate includes how to change the page orientation within Notepad or TextEdit.

Here is a sample script showing the kind of detailed, step-by-step instructions you need to create or receive from a Subject Matter Expert (SME). You are expected to perform each step written below in either Notepad or TextEdit.

Dear Captivate developer, using either Notepad or TextEdit, record the process of changing the Page Orientation from Portrait to Landscape and then back again (from Landscape to Portrait). Create the recording using a capture size of 800 x 600. Thanks. Your pal, the Subject Matter Expert.

1. Click the File menu.
2. Click the Page Setup menu item.
3. Click the Landscape orientation button.
4. Click the OK button.
5. Click the File menu.
6. Click the Page Setup menu item.
7. Click the Portrait orientation button.
8. Click the OK button.
9. Stop the recording process.

The script sounds simple. However, you will not know what kind of trouble you are going to get into unless you rehearse the script prior to recording the process with Captivate. Let’s go ahead and run a rehearsal, just as if you were a big-time movie director and you are in charge of a blockbuster movie.

Places everyone... and quiet on the set...
Student Activity: Rehearse a Script

1. Minimize (hide) Captivate.

2. Start either Notepad (Windows) or TextEdit (Mac).
   
The process of starting either Notepad or TextEdit varies slightly depending on your operating system. For instance, if you are using Windows 7, choose **Start**, type **notepad**, and press **[enter]**. If you are using Windows 8, use the **Search** feature to start Notepad. If you are using a Mac, choose **Go > Applications**. Locate and then open **TextEdit**, and then create a New document.

   In the images below, Notepad is pictured at the left; TextEdit is at the right.

3. Rehearse the script.
   
   - using either Notepad or TextEdit (not Captivate), click the **File** menu
   - click the **Page Setup** menu item
   - from the **Orientation** area, click **Landscape**

   **Note:** In Notepad, Landscape is listed as the word “Landscape.” In TextEdit, Landscape is the **second** tool (shown below).

   - click the **OK** button
   - click the **File** menu
   - click the **Page Setup** menu item
   - click the **Portrait** orientation button
   - click the **OK** button

   *Hey, look at that!* The script worked perfectly... no surprises. You are now ready to work the exact steps again. Only this time, you will record every click that you make. During the recording process, Captivate creates one screen capture each time that you click your mouse.
Software Simulations

You can create software demonstrations or simulations using Captivate. Typical demonstrations include text captions that explain what’s about to happen, and then a mouse automatically moves across the screen to perform the action.

With a simulation, you can have text captions explaining a concept, just like a demonstration, but you can include interactive hotspots (click boxes) that let the user actually perform the required steps.

Between demonstrations and simulations, I recommend you create simulations, especially if you are working by yourself and don’t have the resources to create both a demonstration and simulation for the same lesson. Why are simulations better? It’s always better to let a user perform the step-by-step process you’re trying to teach instead of allowing them to passively watch the steps.

When recording, I recommend you use Captivate’s Custom recording mode. This mode effectively combines Captivate’s Demonstration and Simulation modes. Using the Custom recording mode when you record, Captivate automatically adds text captions and click boxes throughout the lesson that engage your learner.

Student Activity: Set Recording Preferences

1. Leave Notepad or TextEdit running and start Adobe Captivate.

   Note: If you are using Adobe Captivate 8 for Windows, specifically the 64-bit version, start Captivate in Administrator mode. On most computers, running as an Administrator keeps Captivate from behaving erratically. To run Captivate in Administrator mode, right-click the Captivate program icon and choose Run as administrator. When starting Captivate, Windows users may see a “Windows Firewall has blocked some features” alert. If so, click the Allow access button.

2. Set the Mode Preferences for the simulation you are about to record.

   - Windows users, choose Edit > Preferences; Mac users, choose Adobe Captivate > Preferences
   - from the Recording category, select Modes
   - from the Mode drop-down menu, select Custom

   ![Mode Preferences](Image)

   - click the Restore Defaults button at the bottom of the dialog box
   - from the Captions area, select Add Text Captions

   ![Add Text Captions](Image)
from the Click Boxes area, select **Add Click Boxes on Mouse Click** and **Failure Caption**

You selected **Add Text Captions** so that the Text Captions are added for you during the recording phase. *Nice.* And because the captions are written in the imperative, you may be able to use them in the new lesson with little editing. *Nicer.* Everything else has been left deselected except for **Click Boxes** and **Failure Caption** (like the simulation modes). These two settings result in a highly interactive simulation out of the box. *Nicest!*

3. Select a caption to use during the recording process.
   - from the **Recording** category at the left of the dialog box, select **Defaults**
   - from the Text Caption drop-down menu, choose **[Default Capture Caption Style]**

   The change you’ve just made won’t be obvious until after you have recorded a software simulation. At that time, each of the text captions that get created in the simulation will use the Default Capture Caption Style. Next you’ll use the Object Style Manager to control the look of the Default Capture Caption Style.

4. Customize the To Stop Recording keyboard shortcut.
   - from the **Recording** category, select **Keys - (Global)**
   - click in the **To Stop Recording** field and press the [Y] key on your keyboard

   The letter [Y] replaces the key that was in the field by default.

   If you were to move forward and record a lesson using Captivate, you would press [Y] on your keyboard to end the recording process. You can customize the fields in this dialog box to suit your needs. For Windows users, the default key ([End]) works great.
5. Reset the default Recording Keys.

- still in the **Keys - (Global)** area, click the **Restore Defaults** button

**Mac users:** On my Mac, the default **To Stop Recording** shortcut keys `[cmd] [enter]` never works on my MacBook Pro keyboard. I changed the keyboard shortcut to `[control] [e]` and things work perfectly every time. I would suggest that you use `[control] [e]` as your keyboard shortcut too.

- click the **OK** button

6. Use the Object Style Manager to format the Default Capture Caption Style.

- choose **Edit > Object Style Manager**

The Object Style Manager dialog box opens.

- from the middle of the dialog box, select **[Default Capture Caption Style]**

- from the Caption drop-down menu, select **[Default Capture Caption Style]**

- from the **Text Format** area, select any font (Family) and Size you like

- click the **OK** button
Student Activity: Specify a Recording Area

1. Determine what Captivate records.
   - on Captivate’s Welcome screen, click the **New** button
     ![New button]
   - double-click **Software Simulation** (or choose **File > Record new Software Simulation**)
     ![Software Simulation]

   The main Captivate interface hides, and the recording features open.

   On your computer display, notice two things besides Notepad or TextEdit. First, there is a large red box. This is Captivate’s **Recording Area**. Second, there is a control panel containing Size and Recording Type areas. (Pictured below is a Windows desktop that shows Notepad with Captivate’s new recording window on top.)

   ![Recording Area]

   During the next few activities, I’ll show you how to set up Captivate to capture a specific application on your computer. Because of the way Windows and Macintosh applications behave, I’ll need to segregate the activities by platform. Windows users, continue with the next activity. Mac users, go to the “Target a Screen Area” activity on page 17.
Windows Users Only: Target an Application

Set Notepad as the Application to be recorded by Captivate.

- From the top of the recording control panel, select **Application**
- From the **Select the window to record** drop-down menu, select **Untitled - Notepad**

On your screen, notice that the red Recording Area and Notepad now occupy the same space. By specifying Notepad as the Application, Captivate’s Recording Area is now focusing on Notepad.

- From the **Snap to** area select **Custom Size**
- From the **size** drop-down menu, choose **1024 x 576**

The Recording Area resizes to 1024 x 576. And because you selected Application, the Notepad application also resizes to 1024 x 576.

Go to the “Record Screen Actions” activity on page 18.
Mac Users Only: Target a Screen Area

Specify a screen area to be recorded by Captivate on the Macintosh.

- □ from the top of the control panel, select **Screen Area**
- □ ensure the **Set Capture Area to** is set to **Custom Size** and then select **1024 x 576** from the size drop-down menu
- □ drag and resize the **TextEdit** window and the red **Recording Area** until your screen looks similar to the image below (notice that the TextEdit Menu Bar and application window are both within the red Recording Area)

**Note:** If you read through the Windows-only activity just before this activity, you may have noticed that Windows users were able to use the **Application** and **Snap to** options to quickly grab the Notepad application. However, you had to manually specify a capture area. Why? On a Mac, the Application and Snap to options would capture the TextEdit application window, not the application’s menu bar. Because you need to capture TextEdit’s menu bar during the recording process, you can’t use those options.
Student Activity: Record Screen Actions

1. Select the recording mode.
   - from the Recording Type area of the Control panel, select **Automatic**
   
   With this option selected, every click of your mouse during the recording process creates a screen capture. In contrast, had you selected Manual mode, you would need to use a keyboard shortcut to capture the screen.

   - from the Recording Type area, select **Custom**
   - deselect the other modes as necessary

   - ensure that **Panning** is set to **No Panning** and that **Audio** is set to **No Narration**

2. Record screen actions.
   - click the **Record** button and, once the Countdown goes away, use your mouse to click the **File** menu within Notepad or TextEdit
   - click the **Page Setup** menu item
   - from the Orientation area, click **Landscape** and then click the **OK** button
   - click the **File** menu
   - click the **Page Setup** menu item
   - click the **Portrait** orientation button and then click the **OK** button

3. Stop the recording process using the **Stop Recording** key (discussed on page 13).

   **Note:** If the recording doesn’t end after pressing your Stop Recording keys, an alternative technique for stopping the recording process is to click the Captivate icon on the System Tray (Windows) or Dock (Mac).

4. Preview the project. (**Preview > Project**)

   As you move through the recording, notice that there are Click Boxes (hot spots) that make this lesson 100 percent interactive. Also notice that the Text Captions are written in the imperative to encourage interactivity. There may be one or two captions you would need to edit, and some of the buttons are likely misnamed, especially on the Mac side. Nevertheless, much of the work is done.

5. When finished previewing the lesson, close the preview.

6. Close the project (there is no need to save it).
Custom Recording Confidence Check

You have been asked to bookmark a website so it can be accessed quickly in the future. The process of creating a bookmark (a Favorite) varies depending on the web browser you are using. For instance, if you are using Internet Explorer, you could choose the Favorites menu, click the Add to Favorites button and then click the Add button. If you are using Google Chrome, you could click the Bookmark button and then click the Add button. If you are using Firefox, you could choose Bookmarks > Bookmark This Page. If you are using Safari, show the Menu bar, choose Bookmarks > Add Bookmark, and then click the Add button.

1. Using your browser of choice, use the Custom recording mode to create a video that simulates the process of creating a Bookmark (Favorite) for any website that you like.

   Not sure how to proceed or what exactly to record? Use Captivate to open the project named Bookmarking.cptx (you can find it within the Captivate8BeyondData folder). Preview the project and you’ll see that I’ve created a video of the bookmarking process in each of the browsers mentioned above. You need to do the same in any browser you want. Forgotten how to record screen actions? See page 18.

2. When finished recording, save the new project to the Captivate8BeyondData folder as CreateFavorite.

3. Preview the project.

   Notice that there are text captions and interactivity, which is wonderful. However, none of the captions contain end-of-sentence punctuation. While I am not a fan of end-of-sentence punctuation, many corporate style guides insist on end of sentence punctuation.

   Believe it or not, it is possible to “pre-edit” the text captions and change, among other things, the text that appears in the captions and the way Captivate treats end-of-sentence punctuation. You’ll delve into that next. This little bit of wizardry just might save hours of additional editing.
Caption Pre-Editing

As you have just seen when you recorded a lesson using the Custom mode, Captivate created the text captions for you. Those captions are written in the imperative, which is great. However, there are a couple of ways to write an instruction. For instance, if you want to instruct a user to select the New command from a menu, you could lead the instruction with the word “Select” or “Choose”:

1. Select the New menu item
2. Choose the New menu item.

Captivate automatically uses the word “Select” when it creates text captions. However, if you want the text caption to use the word “Choose,” you’d have to make the change manually after the recording process is complete. Although not difficult, this kind of editing is labor-intensive. And as I mentioned on the previous page, end-of-sentence punctuation is a debatable topic. Do you or don’t you? I don’t, but you might not agree.

To save a significant amount of text editing during post-production, you can pre-edit the text captions by editing one of the language template files that are stored in the Captivate application folder on your hard drive. Captivate uses these files during the recording process when it creates the text captions.

Student Activity: Edit a Text Capture Template

1. Minimize/Hide Adobe Captivate.

2. Locate the file that controls the text that appears in automatic text captions.
   - navigate to the folder where Adobe Captivate 8 is installed on your computer (Windows users, the path is typically Program Files/Adobe/Adobe Captivate 8; Mac users, Captivate is typically in a folder named Adobe Captivate 8 that is located within the Applications folder.)
   - find (but do not open) CaptureTextTemplates_English.rdl file

This next step is possibly the most important. You are going to create a copy of the English rdl file. If you foul up the duplicate rdl file, no worries because you can simply throw it away. The changes you are about to make to the duplicate rdl file will have no impact on the original rdl file.

   - select the CaptureTextTemplates_English.rdl file and then copy and paste it into the Captivate 8 application folder (the current folder)

Note: You may be prompted to confirm the action, which you should do. Because you are pasting a file directly within the application folder, you may be blocked completely because of limited read/write access to the application folder. In that case, you will need someone within your IT team to grant you read/write access to the Captivate application folder on your computer. Otherwise, you will be unable to complete the remaining steps in this module.
4. Rename the duplicate rdl file.
   - change the name of the duplicate rdl file to 
     `CaptureTextTemplates_YourFirstName.rdl`

   Check for typos in your new file name. In the image below, notice that Biff has 
   created an rdl file named `CaptureTextTemplates_Biff.rdl`. You will be 
   editing your personal rdl file next.

![Image of file directory]

5. Open `CaptureTextTemplates_YourFirstName.rdl` with NotePad (Windows) or 
   TextEdit (Mac).
   - Windows users, right-click your rdl file and choose Open; 
     Mac users, double-click your rdl file

   If the file does not automatically open within NotePad (Windows) or TextEdit 
   (Mac), you may need to lend a helping hand.

   - Windows users, if a “Windows cannot open this file” dialog box (or similar) 
     appears, choose Select a program from a list of installed programs 
     and then click the OK button; Mac users, select Choose Application

![Image of dialog box]

   The Open With dialog box (Windows) or Choose Application dialog box 
   (Mac) appears.
Windows users, select **Notepad** from the list of available programs and click **OK**; Mac users, select **TextEdit**

In the images below, the Windows **Open With** dialog box is shown first; the Macintosh **Choose Application** dialog box is shown second.

The rdl file opens in the text editor. If you are familiar with programming languages like HTML or XML, you will likely recognize the tags used in the document. If you do not have programming experience, no worries, you will be able to edit the template either way.

☑ scroll down to the part of the document shown below (if you have trouble finding the text, use the Find feature available in both Notepad and TextEdit to find Object Name="Menu")

```xml
<Object Name="Menu" DefaultTemplate="Select the %s menu">
```

This is the part of the document that controls the words “Select” and “menu item.” If you edit the text in this part of the template, the automatic text captions created during the recording process allow you to skip much of the editing process during the post-production phase. For instance, if you want the word Choose to appear in the text captions instead of Select, you’d change only the word Select to Choose. And if you want each of the text captions to end with a period, all you need to do is add a period just to the left of the closing quote.

☑ at the end of the Object Name="Menu" line, click between the u in menu and the closing quote
☑ type a period

```xml
<Object Name="Menu" DefaultTemplate="Select the %s menu.">
```

7. Save your work. (Keep the file open.)

**RDL Editing Confidence Check**

1. In the image below, I’ve added periods to the end of several lines of text. Spend a few moments adding periods on your own.

```xml
<Object Name="Menu" DefaultTemplate="Select the %s menu.">
<Event Name="LeftDBClick" Template="Double-click the %s menu.">
<Event Name="RightClick" Template="Right Click the %s menu.">
<Event Name="RightDBClick" Template="Double-click the %s menu.">
<Event Name="MiddleDBClick" Template="Double-click the %s menu.">
<Event Name="KeyPress" Template="Press %s key for %s menu.">
</Event>
<Object Name="MenuItem" DefaultTemplate="Select the %s menu item.">
<Event Name="LeftDBClick" Template="Double-click the %s menu item.">
<Event Name="RightClick" Template="Right Click the %s menu item.">
<Event Name="RightDBClick" Template="Double-click the %s menu item.">
<Event Name="MiddleDBClick" Template="Double-click the %s menu item.">
<Event Name="KeyPress" Template="Press %s key for %s menu item.">
</Event>
</Object>
```

2. As an experiment, change the words Select the %s menu item to Choose the %s command. (During the recording process, let’s see if this has any effect on the text that appears in your text captions.)
3. Save and close the text file.

   **Note:** If you experience trouble saving the rdl file to your hard drive, you may succeed by first saving the rdl to the desktop. From there, you can copy/paste the rdl file into the Adobe Captivate folder.

4. Return to Captivate and open Captivate’s **Preferences** dialog box.

5. Select the **Recording** category from the list at the left.

6. Select your name from the **Generate Captions In** drop-down menu.

   ![Generate Captions In:](image)

7. Using your browser of choice, use the **Custom** recording mode to create another video that simulates the process of creating a Bookmark (Favorite) to any website you like. During the recording process, also select a menu or two and a menu item. (Need help recording screen actions using Custom mode? See page 12.)

8. When finished recording, save the new project to the **Captivate8BeyondData** folder as **CreateFavorite_CustomCaptions**.

9. Preview the project.

   The text captions should now contain end-of-sentence punctuation. In addition, if you used a menu when creating the Favorite, the text in the captions where you selected a menu command should now begin with **Choose** instead of **Select** and end with **command** instead of **menu item**.

   **Note:** You can use the original English rdl file at any time by choosing **English** from the **Generate Captions In** drop-down menu.